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STYLE GUIDE 

INTRODUCTION 

The Busch School of Business will teach you vital business skills and prepare you for the work 

environment. This Style Guide will help transition you from writing in an academic style to the 

business writing style of the business professional. 

Writing in the workplace (business writing) and writing in the academic environment academic 

writing) differ in purpose, format, style, and mechanics. Your ability to communicate effectively 

in the workplace, both verbally and in writing, is a critical skill highly valued by employers. 

Employers want employees who communicate productively with fellow employees and company 

supervisors, as well as with customers—in-person, online, in writing, on social media, or on the 

phone. Excellent communication skills distinguish employees with high potential from other 

applicants. Business professionals who communicate well are in high demand in today’s 

competitive hiring environment. 

The Style Guide will introduce you to the business writing style used in The Busch School and 

by many companies. Unfortunately, the academic writing concepts, style, format, and mechanics 

learned and perfected over your years of practice are not particularly effective in the workplace.  

Recipients of business communication are time-constrained individuals, inundated with 

information, busy schedules, high priority email, competing meetings, phone calls, and text 

messages, etc., every day.  

Business writing is to-the-point, brief, and designed so the reader quickly gleans the essence of 

the communication. To excel in the workplace, employees must communicate clearly, concisely, 

and accurately—without poor punctuation, sloppy formatting, bad grammar, or incorrect word 

use. Business writing starts with the conclusion, uses bulleted lists, white space, and other 

formatting not favored in the academic setting. Businesses follow a style tailored to their 

branding. Although an organization may have a writing style/format that differs from the Style 

Guide, the transition to their unique style should be easy since we based this guide on common 

workplace concepts.  

Your Busch School professors will expect your written and verbal communication to follow the 

format, concepts, and style presented in the Style Guide. 

Welcome to the exciting world of business communications! 

 

Bob Powers 

Adjunct Assistant Professor 

The Busch School of Business 

The Catholic University of America 

powersrf@cua.edu 

 

mailto:powersrf@cua.edu
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WRITING STYLE 

Business writing differs from academic writing in format, tone, and method. In business, you 

strive to have your written and oral communications: clear (simple and easy-to-understand), 

concise (brief and to-the-point), correct (accurate and error-free), and tailored to your audience 

(you-focused).  

In academic writing, your goal is to impress your audience with what you know and to show how 

your mind works. In business, you communicate to express an idea, to solve a problem, to 

recommend an action, to articulate policy and processes, to communicate with clients, to support 

strategic courses of action, or to propose new strategies or company direction.  

Business communications are: 

• “Actions” you take (how you act / what you say / what you write / how you work with 

others / etc.) 

• “Things” you say (in conversation / on the phone / at a meeting / in a speech / in social 

media / etc.) 

• “Words” you write (email / letters / memos / presentations / text messages / speeches / 

Excel workbooks / reports / social media posts / etc.) 

In business, do not waste people’s time by making them decipher your message (make sure your 

message is clear). Remember, strong, well-chosen words make an impact and the fewer words it 

takes to accurately describe something, the better. Relate your content to the recipient and make 

sure you are not using industry jargon they may not understand.  

Your communications style and tone may vary depending on your intended audience. In 

business, it is OK to use casual, conversational, easy-to-understand language.  

Unless otherwise directed, use the guidance in the Style Guide for your Busch School writing 

assignments. When you write: 

• Start with your conclusion (then make your case in order of importance)—this is the 

“Bottom Line Up Front” method  

• Take the same approach with each paragraph (put the main point of the paragraph in the 

first sentence of that paragraph)  

• Synthesize key points into bullets (follow each bullet with a brief summary of the point) 

• Write in active voice and use first-person references like “us”, “we”, and “our team” 

(limit your use the pronoun “I” to not more than two times in your document—

remember: your communication is about the receiver, not about you!) 

• Keep your communication short (do not dilute your message and waste space with 

wordy, roundabout sentences) 

• Keep it conversational, yet polished (be polite in your writing, but do not be afraid to 

make bold statements) 



Style Guide 

July 2021 2  

• Use short paragraphs, lists (bulleted or numbered), headings, bold and italic fonts, tables, 

graphs/charts, and illustrations 

Writing is a Process. Improve your writing by following the writing process. Incorporate the 

process into all your communications efforts whether for written (documents, email, or 

presentations, etc.) or oral (speeches, phone calls, meetings, etc.) challenges.  

The writing process is a three-by-three matrix (Prewrite, Draft, Revise). Those who consistently 

produce superior documents and presentations follow all nine steps in the writing process. Please 

note that the “writing” part does not begin until Step #6. Eliminating or rushing through Steps #1 

to #5 detracts from the quality of your message. Also, not completing Steps #7 to #9 (Revising) 

is a fatal flaw that may cause your message to fail. 

 

Adapted from "Essentials of Business Communication, 11e, by Guffey and Loewy ©2018 
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Document Focus. Keep a “You” focus in your message. In other words, explain how your 

recommendation/proposal will benefit the reader or the reader’s organization. Why should the 

recipient do something that just helps you? Readers do not care about the benefits to you or your 

organization. They want to know “What’s in it for me and my organization?”. 

Bottom Line Up Front. In business writing, put the essential point(s) first (why are you 

writing the document, what action do you want someone to take, what is the topic of the 

paragraph, etc.?). This differs significantly from academic writing where the conclusion 

normally comes at the end of the document. Top business writers present important information 

first and use the rest of the document to support it.  

The recipe for successful business communication:  

1. Briefly state the issue (usually not more than one sentence) 

2. Succinctly present the answer, recommended action, or path forward (usually not more 

than one sentence) 

3. Articulate the reasons why you recommend the action (three to four reasons with the 

most important reason first followed by others in order of decreasing importance; keep 

the explanation to one short paragraph for each reason) 

Cover Sheet. Unless directed otherwise by your professor, do not use a cover sheet. 

Binding. If you use more than one sheet of paper, staple all sheets together with a staple in the 

upper left corner. Do not use a paper clip since paper-clipped pages can become easily separated. 

Unless your professor specifies, do not use folders, binders, or other covers for Busch School 

assignments. 

Corrections. In today’s world of computer automation, NEVER submit a business document (or 

any document) with pen and ink corrections. If you discover an error after completing and 

printing the document, use your computer to make the correction, re-print the affected pages, and 

insert the revised pages into the document, presentation, or workbook. 

Signature Block. The Signature Block is another critical element that identifies your 

documents in business correspondence.  

Your goal 

• Use a consistent Signature Block format to easily identify you and your documents 

• Do not waste the recipient’s time searching multiple files for specific content or to 

identify the document’s author 

• Classroom Assignments. Use a standardized, left-justified, single-spaced Signature Block to 

identify your work. Create a Signature 

Block with your name on the first line 

of the first page; on the second line, 

write your class identification and the 

date submitted (in standard US 

business format), e.g., MGT 250-01 - 

Classroom Assignment Signature Block 

Bob Powers 

MGT 250-01 – September 1, 2021 

The Benefits of Excellent Communications 
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September 15, 2021; on the third line, write the title of the document (for classroom 

assignments, use the assignment title as the title for your document). Do not place your 

Signature Block in the header or footer.  

• Excel Spreadsheets. Show your name, class, date submitted, and project title in the header, in 

the footer, or in cell A1 of the spreadsheet. In all cases, ensure that your signature block 

information shows when you print the document. Your professors may give you unique 

naming or marking directions for their assignments. 

• Slide Presentations. Slide presentations, also known as slide decks, should always have your 

identification shown on the first page, in the header or footer if using Conference Room Style 

(see Presentations on page 26), or on the Title Page for Ballroom or Traditional PowerPoint 

Style presentations. Your identification should include the presentation title, your name, date 

presented, and affiliation, e.g., class number, etc. 

• Email Signature. All email should have a signature block. Your Email Signature should 

include: your name, professional title, department name, identification of the University, 

contact phone number, email address, and the University's general URL (catholic.edu). You 

may also include the University's approved 

wordmark for the Busch School or for the 

University in your signature. Do not use your 

Email Signature to promote outside organizations 

or activities not associated with Catholic 

University or include links to any non-University 

website. 

Create your Email Signature with a standardized, 

single-spaced, left-justified complimentary closing 

and full contact information, inserted by default, 

on all email you create, reply to, or forward. 

Include your name, title, and full contact 

information (including your Catholic University 

email address and office, and/or cell phone 

number, as appropriate). Including the University 

or Busch School official wordmarks is optional. Students may choose to omit their personal 

phone number to enhance personal security. If you prefer to type a unique, complimentary 

closing on each email, do not include it with your default Email Signature. 

Document Length. People in business are normally busy and do not have time to read 

everything received in detail. The best business letters, memos, etc., do not exceed one page. 

Critical email should not exceed one screen length. If your correspondence is concise, clear, 

organized, well-written, error-free, and gets to the point quickly, your reader generally responds 

positively and takes the desired action. Receivers of long, obtuse, poorly organized, or error-

filled correspondence normally put them aside with no action. Investing time up front to make 

your document concise and complete, avoids misunderstandings and time wasted answering 

clarification questions and other avoidable follow-ups. 

Best Regards, 

Bob Powers 
Class of 2023 
The Busch School of Business 
The Catholic University of America 
202-319-XXXX  
powersrf@cua.edu 
catholic.edu  

 

Sample Student Email Signature 

http://www.catholic.edu/
mailto:powersrf@cua.edu
http://www.catholic.edu/
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Paragraph Length. Business writing must be concise with short, clear paragraphs and 

sentences. Paragraphs in letters and memos should have about 4-5 printed lines (2-3 sentences or 

less); paragraphs in reports can be up to 7-9 lines long; email paragraphs are shorter. Business 

writers focus on the main idea or action desired. They use active voice to do it. Passive verbs, 

vague references, and more-than-three preposition phrases in a single sentence cause excessive 

wordiness and confusion.  

Sentence Length. Business writing is easier to read if you use shorter sentences. Shorter 

sentences usually have one main idea that readers can quickly grasp and easily remember. Long 

sentences, with multiple ideas, can be difficult to understand and remember. Express your ideas 

clearly and concisely. Forget complicated sentences—save them for your academic writing 

efforts. Short sentences let the reader focus on one thing at a time and to react to each idea in 

sequence. The eye moves much faster through short, simple sentences. As a result, there is no 

need to re-read earlier sentences to follow the train of thought. (Berry Writing Group, Inc.)  

Superior writing uses a variety of sentence lengths. A document with all 8- to 10-word sentences 

would be choppy. With all 20- or 25-word sentences, the reader soon loses interest. Vary your 

sentence length with an average sentence length of not more than 15 to 20 words.  

Sentence Length Comprehension Rate 
 8 words  100% 

 14 words  90% 

 19 words  80% 

 28 words  50% 

 43 words  <10% 

Source: American Press Institute 

The average sentence length in academic documents is 20-28 words. Better business writing 

sentences average 15-20 words or less. If your sentence has over 30 words, condense it or break 

it into multiple sentences. 

To shorten your sentences:  

• Separate independent clauses joined by “and” or “but”—make them individual sentences  

• Make new sentences out of “which” clauses  

• Delete unnecessary words 

• Write in the active voice (See: Active versus Passive Sentences, p. 16) 

 

  

 

Write in plain English and get to the point right away. Businesspeople do not want to interpret 

your writing. Shorter sentences help the reader to quickly understand the purpose of your 

writing. 

Document Sentence Length 

Letter / Memo / Email  12 to 15 words 

Report / Technical Document 20 or fewer words 
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BOTTOM LINE: The longer the sentence, the less your audience will understand. To 

improve comprehension, condense longer sentences or break them into shorter ones.  

(Press Relations Society of America) 

Business Writing Style and Grammar Guides. There are numerous published writing, 

style, and grammar guides. The following are the standards used by many businesses and 

excellent choices to add to your personal professional library. 

Grammar Guide 

The Elements of Style 

Style Guides 

• The Associated Press Stylebook 

• The Chicago Manual of Style 

• The Gregg Reference Manual 

Business Writing Format and Style 

• The Business Writer’s Handbook 
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Grammar, Punctuation, and Capitalization 

Acronyms. Do not assume your audience knows your abbreviation. Spell out acronym titles on 

the first reference, followed by the acronym in parenthesis, e.g., “The Internet Marketing 

Association (IMA) is a fast-growing internet marketing group. The IMA represents . . . .” 

Address Format. Use the USPS format when writing the city, state, and zip code as part of a 

mailing address in a letter, e.g., Washington, DC 20064. (Please note that there is no comma 

between the state and zip code.) USPS uses an all-capital, no-punctuation format for mailing 

addresses on envelopes, e.g., THE CATHOLIC UNIVERSITY, 620 MICHIGAN AVE NE, 
WASHINGTON DC 20064. Follow the Associated Press Stylebook when referring to a city 

and state without zip code, e.g., Washington, D.C. Spell out state names (no abbreviation) when 

they appear alone, e.g., Maryland. 

Ampersand (&). Avoid in correspondence unless part of a proper name, tagline, title, or 

subheading. 

Apostrophe. For plural nouns that do not end in an “s,” add an apostrophe “s” to the end of the 

word. For nouns that end in an “s,” add only an apostrophe, e.g., several businesses’ websites. 

Do not use an apostrophe to make a word plural, e.g., URLs, iPhones, FAQs, 1990s. 

Capitalization. Avoid using all caps, as it GIVES THE IMPRESSION OF YELLING.  

Commas. Pay attention to your use or non-use of commas. Commas can be extremely effective 

when used correctly. Unfortunately, missing or incorrectly used commas detract from your 

document and may even create a different meaning. The Busch School and Catholic University 

follow the convention of inserting a comma before the coordinating conjunction (usually “and” 

or “or”) in a series of three or more terms, e.g., “The colors are red, green, and blue.” (Not: 

“The colors are red, green and blue.”). This use of commas is known as the “Oxford comma” or 

“Serial comma”.  

Company and Product Names. Follow an organization’s conventions as to how it 

capitalizes and punctuates its name—paying special attention to capital letters in the middle of 

the name and punctuation, e.g., eBay, HubSpot, YouTube, PowerPoint. 

Dates. Write out the entire date, including the name of the month with a comma after the day, 

and a four-digit year, e.g., January 1, 2021. Use cardinal numbers (e.g., 1, 2, 3) for the day, not 

ordinal numbers (e.g., not:1st, 2nd, 3rd). Do not abbreviate the month. Although you say: 

January first two thousand twenty-one, you write: January 1, 2021. This is the standard US 

business format; other countries and the US military may use other formats. It is also not correct 

to use a purely numerical form of the date in business documents (e.g., not: 1/1/2021). 

• Correct: January 1, 2021 

• Not Correct: January 1st, 2021 

• Not Correct: January 1, 21 

• Not Correct: January 1/2021 

• Not Correct: 1/1/21 

• Not Correct: 1/2/2021 
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When writing a date with only the month and year, e.g., in your resume, do not use a comma 

between the month and year.  

• Correct: January 2021 • Not Correct: January, 2021 

• Not Correct: January, 21 

• Not Correct: January 21 

Ellipses. An ellipsis is a series of three points with spaces between them (. . .) inserted into a 

quotation to show the omission of a word, phrase, etc. from a quoted document. Use ellipses 

sparingly in your document. 

Email Subject Lines. Use sentence capitalization and punctuation for email subject lines. If 

your subject line is a question, end with a question mark. Avoid using title capitalization and all 

caps. Keep subject lines short (five to seven words), e.g., “Do you like to eat fresh fruit?” / “You 

can’t compare apples to oranges” / “The best way to eat kiwi fruit”. 

Em dash. Use an “em dash” (—) to set apart entire phrases from the main body of a sentence. 

Do not separate the em dash from the words that precede and follow it. (Tip: Microsoft Word 

automatically converts two dashes in a row to an em dash after typing the next word and a space 

after it; WordPress automatically converts three dashes in a row to an “em”, e.g., If you want to 

know—and surely you do—then you must ask.) If your software does not automatically create an 

em dash, you can substitute two hyphens with no spaces for the em. You can also insert an “em 

dash” with the “Symbol” dropdown menu on the “Insert” tab or by using the Alt Code 

(ALT+0151). Do not use a single hyphen to represent a dash. 

Exclamation points. Use one exclamation mark to convey a tone of excitement in your text, 

e.g., I dig it! (Not “I dig it!!!!”). Use exclamation points sparingly. For maximum effectiveness, 

limit the number of sentences that end with an exclamation mark to not more than one per 

paragraph. 

Grammar. Spelling and punctuation errors, poor grammar, sloppy layout, or awkward sentence 

structure detract from your written or verbal message—from email to letters, memos, reports, 

and presentations. These mistakes decrease customer confidence in you and deflate your status 

with supervisors. Academic writing follows MLA and APA styles. Most businesses follow The 

Chicago Manual of Style or The Associated Press Stylebook. Businesses choose a style that fits 

their branding and makes their correspondence, web site, and social media presence consistent 

and easily identifiable as their business. 

Numbers. There are many grammar rules, practices, and exceptions concerning the writing of 

numbers. The Chicago Manual of Style describes the most common formats.  

• Write the word for whole numbers from zero to nine.  

• Write the digits for numbers 10 and greater.  

• Write the word when the number begins a sentence, except write the digits when the year, 

e.g., 1776, begins a sentence.  
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• Write the digits for dimensions, currency, percentages, ages, distance, decades, centuries, 

and computer storage capacity.  

• Write large numbers in numerals followed by million, billion, and so forth.  

• Write numbers greater than 999 in numerals, with a comma, e.g., She has nine cats, but 

he would like 90. One hundred would be too many. So would 5,000. One billion is out of 

the question.  

• Write compound numbers between 21 and 99 with a hyphen, e.g., twenty-one, twenty-

first.  

• Write the simpler form when there are two ways to express a number in words, e.g., 

fifteen hundred rather than one thousand five hundred.  

• For ages, always use digits, e.g., “The girl is 8 and her brother is 11.” 

Money. Write the dollar sign and the digits (do not use the word “dollars”), e.g., $6.57. For 

whole dollar amounts, do not use the decimal point and two zeros, e.g., $5 a ticket, unless the 

amount occurs in the same context as an amount with dollars and cents (one ticket is $5.00 and 

two tickets are $9.50). For dollar amounts of a million or more, use the dollar sign, digits, and 

words, e.g., $28 million. For amounts under a dollar, write the digits and the word “cents”, e.g., 

72 cents. 

OK. Not o.k. or okay. 

Percentages. Written as digits with the % symbol. Avoid starting a sentence with a 

percentage, e.g., Did you know 98% of statistics are made up? If you must start a sentence with a 

percentage, write out the words, e.g., Eighty percent of sophomores use Metro transportation. 

Periods. One space after periods and at the end of sentences is proper when using a 

proportionally spaced or variable-width font like Times Roman, Arial, or Calibri. For a 

monospaced or fixed-width font like Courier, use two spaces. Proportionally spaced fonts use 

varying widths for each letter or symbol. Monospaced fonts use the same space or fixed width 

for every character. 

Pronouns. When referring to a company, use the third-person singular pronouns “it” and “its”. 

A company is treated as a collective noun and requires a singular verb and a singular pronoun. It 

is also acceptable to use third-person plural pronouns to describe your organization, e.g., “we”, 

“they”, “our team”. Since your message needs to emphasize reader benefits, limit your use of 

the “I” pronoun to not more than two “I” in your message. In business writing, keep a “you” 

focus—it is not about you, it is about your reader! 

Time. Use cardinal numbers and a.m. and p.m. to show the time. Use “noon” to say 12 p.m., 

e.g., The noise from the party across the street woke me from a sound sleep 12 a.m. and 4 a.m., 

unfortunately, I fell asleep at my desk at noon. 

Titles. Capitalize the first letter of every word in titles 
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DOCUMENT FORMATTING 

Paper. The standard business stationery is unlined, white bond paper, 8½ x 11 inches in size, 

20lb. weight. Most businesses use printed letterhead for correspondence. In the Busch School, 

white copier paper is acceptable for classroom submissions. 

Format. The Busch School and most businesses follow the Block Format writing standard for 

all electronic and printed documents, including email. In Block Format, you write with single-

spaced, left-justified text (text aligned with the left margin) with a 12-point space between 

paragraphs. Do not indent paragraphs.  

To set up your computer to produce documents that follow the standard business style, follow the 

instructions in Appendix H. If you do not want to follow the business standard for all documents, 

create a business document template as described in Appendix I 

Follow these steps to make Block Format your default format for documents created with 

Microsoft Word.  

• Make your default paragraph line spacing as “Single”, with “0 pt.” spacing before the 

paragraph and “12 pt.” spacing after the paragraph.  

• Ensure that “Don’t add space between paragraphs of the same style” is not checked 

(Paragraph spacing will be inconsistent if this box remains checked!).  

• To enter a single line space between paragraphs, e.g., when writing an address, hold 

down the “Shift” key and press “Enter” to insert a manual line feed.  

Margins. Business writers use one-inch margins on the top, bottom, right, and left. One-inch 

margins all-around are The Busch School and The Catholic University standard. Unfortunately, 

word processors, like Microsoft Word, use non-standard margins as their default margins. When 

formatting page layout in Microsoft Word or other word processors, use one-inch or “normal” 

margins. Set “Normal Margins” (one-inch margins all around) as the default for documents 

created with your word processor. (See “Computer Setup for Business Documents”, pages H-1 

and H-7) 

Fonts. The traditional business correspondence font is Times New Roman, 12-point. Some 

businesses may specify other fonts for their correspondence, reports, memorandums, etc., e.g., 

Arial, Helvetica, or Garamond, etc., depending on the company’s branding.  

For class assignments, use either Times New Roman or Arial, 12-point. Avoid using unusual 

fonts that distract from the content of your writing, e.g., Comic Sans. Use the same font, size, 

CAUTION—Do not use the default paragraph, line spacing, and font created 

by Microsoft Word, Word for MAC, Apple Pages, and Google Docs. Their line 

spacing may look like single-spaced but may be 1.08 or 1.15 lines—not the 

single-space business standard. Their default paragraph spacing may be 8-point 

or 10-point—not the 12-point business standard. Appendices H-1 and H-7 offer 

detailed setup instructions for both Windows and Mac computers.  
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and font color throughout your entire document, except for headings, which may use a larger 

font size, a bold typeface, and/or a different font.  

Calibri, 11-point, is the Microsoft default font in Excel and Outlook. Microsoft specifically 

designed and engineered Calibri to be highly legible, for both alphabetical and numerical 

characters, and to make both numbers and text easier to read on handheld devices. Use Calibri, 

11-point, a sans serif font, in Excel spreadsheets and for email (For Cardinal Mail, use the “Sans 

Serif” font, “Normal” size; this is the same as Calibri, 11-point).  

The font box shows alphabetical and numerical characters formatted in the Times New Roman, 

Arial, and Calibri, 11-point fonts; note that the Calibri font needs less space than the others. 

(Journal of Accountancy) 

Standard Business Document Format 

Font Times Roman / Arial, 12-point 

Margins One inch (top, bottom, right, left) 

Paragraph Block Format Flush Left  

Line Spacing Single Space (1.0 lines) 

Paragraph  
Spacing 

Format spacing with 0 pt. before and 12 pt. after paragraph 

Headings and Sub-Headings. The main purposes of business writing are to motivate readers 

to behave in a certain way and to re-enforce the business’s branding. Businesses use headings, 

sub-headings, and white space to make their documents eye-catching and memorable.  

Business documents use headings and sub-headings to show and organize information. Headings 

help readers skim the document for desired and critical material, find information covered in 

bullet points, and improve reader ability to find topics. Business authors use section and 

paragraph headings and sub-headings because they do not assume that the reader will start at the 

beginning and finish at the end of the document. The reader may choose to read only certain 

Times New Roman 

ABCDEFGHIJKLMNOPQRSTUVWXYZ 

abcdefghijklmnopqrstuvwxyz1234567890 

Arial 
ABCDEFGHIJKLMNOPQRSTUVWXYZ 

abcdefghijklmnopqrstuvwxyz1234567890 

Calibri 
ABCDEFGHIJKLMNOPQRSTUVWXYZ 

abcdefghijklmnopqrstuvwxyz1234567890 
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parts of the document. Section and paragraph headings help readers find information. This guide 

uses paragraph and section headings to assist the reader.  

Effective bullet points need effective headings. When using a heading, capitalize the first letter 

of every word (like with titles) unless it is in sentence form—then use sentence capitalization and 

punctuation.  

Lists (Bullet Points and Numbered Lists). Business writing must be concise and well 

organized. Format business documents with bullet points and numbered lists to help readers 

quickly find essential information.  

The purpose of a bullet point is to present data in an easy-to-read format that allows the reader to 

scan the information quickly. Make lists short, concise, and easy-to-scan. Capitalize the first 

word of each item. Write bullet points as dependent clauses, phrases, or as one or two words that 

convey the essence or purpose of the bullet point. When a bullet point gives detailed instructions, 

write and punctuate it as a complete sentence. Keep your lists simple and avoid using sublevel 

bullet points. 

Business writers use bullet points and numbered lists to: 

• Organize and emphasize information 

• Highlight and draw attention to essential information 

• Help readers scan information easily 

• Improve document readability 

Bullet points hints:  

• Use strong headings to group related items together (helps the reader find information) 

• Keep bullets short and to-the-point (not more than two lines long—one line preferred)  

• Ensure consistent format within each list (improves document readability) 

• Make all bullet points about the same length (enhances scanning value) 

• Use parallel form for bulleted lists (begin each bullet with the same part of speech) 

• Use the same font and margin width for each bullet point (consistency matters) 

• Use periods at the end of each line only for complete sentences (boosts comprehension) 

White Space. Everyone’s eyes like white space. Airy, white space in a document promotes 

pleasurable reading and improves readability by directing the reader’s eye. To create white 

space: 

• Use normal margins / informative headings / clear sub-headings 

Caution: Overusing bullet points detracts from the overall goal of business 

writing. Only use bullets to highlight and emphasize key information. 

(Montana State University) 

General rule—do not use sentence punctuation unless the bullet point is 

a complete sentence.  
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• Follow a consistent format and font 

• Use bullet points and numbered lists 

• Format important words with bold, italic, or underlining 

Google Workspace. Google Workspace (formerly known as G Suite) is available to Catholic 

University students. Common services include: 

Gmail  Web-based email platform 

Google Drive Cloud Drive; unlimited storage space; access files from any device 

Google Docs Web-based word processing; create / edit documents online; real-time collaboration  

Google Sheets Web-based spreadsheet; create / edit spreadsheets online; real-time collaboration 

Google Slides Web-based presentation tool; create / edit presentations online 

Google Calendar Web-based calendar platform 

Google Drawings Web-based diagramming software; create flowcharts, mind maps, concept maps, and other images 

Although some companies transitioned to these Google apps, the industry standard file format 

for documents, presentations, and spreadsheets is still the Microsoft Office Suite. Unfortunately, 

Google Docs, Sheets, and Slides files are not directly compatible with Microsoft Office files. 

However, if you use these Google apps, you can still work with Microsoft Office files, even if 

you do not have Office installed on your computer. Please follow the instructions in Appendix F 

to convert files to/from the Google or Microsoft format as appropriate.  

Number of Spaces after a Period and other Punctuation. The preferred number of 

spaces after a period or other punctuation is one-space when using a proportional-spaced font 

like Times New Roman or Arial. The exception is when using a monospaced font like Courier, 

where a double blank space follows a hard sentence break. Two spaces after a period are a 

holdover from when writers used typewriters with monospaced fonts and writing style mandated 

two spaces after any full stop (period, question mark, or exclamation mark). Some organizations 

still follow the two-space rule as part of their branding. The Busch School and Catholic 

University use one-space after periods and other full stops. Whichever convention you follow, 

make sure that the number of spaces after a hard stop is consistent throughout your document. 

File Format. The correct file format for class assignment documents is a Microsoft Word 

“.docx” or “.doc” file. For spreadsheets, the correct file format is a “.xlsx” or “.xls” file. For 

presentations, the correct file format is a Microsoft PowerPoint “.pptx” or “.ppt” file. 

Occasionally, a professor may also ask that you save an assignment file as an Adobe Acrobat 

“.pdf” file. Do not turn-in a file in .pdf format unless your professor specifically requests it. 

Except for unique database files, these seven file formats (.docx, .doc, .xlsx, .xls, .pptx, .ppt, or 

.pdf) are the only formats acceptable for classroom assignments.  

https://www.google.com/gmail/
https://www.google.com/drive/
https://www.google.com/docs/about/
https://www.google.com/sheets/about/
https://www.google.com/slides/about/
https://www.google.com/calendar
https://docs.google.com/drawings/
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Unless your professor specifically requests you to submit an assignment using the format of one 

of the Google Workspace apps, convert your assignment into the appropriate Microsoft Office 

format before submission. See Appendix G for the steps to convert G-Suite files into Microsoft 

format files. 

Documents submitted in Apple’s Pages, Numbers, Keynote, or other non-standard business 

formats are not acceptable alternatives; professors will reject them. You may still use these 

Apple-unique programs to create your documents; however, you must convert your files into the 

proper Microsoft Office file formats before you send them to your professor. Appendix G has 

instructions for exporting Pages files into the MS Word format. Follow similar directions to 

convert Numbers and Keynote files into acceptable spreadsheet and presentation formats. 

File Naming. In the workplace, you will send documents to others as email attachments, will 

post files to network servers, and will post files in the cloud. Inadequate file naming causes 

confusion and lost files.  

For Classroom Assignments—Name your files with your last name, the Catholic University 

course ID, a short (five words or less) description of the file contents, and the six-digit date 

(either MO-DA-YR or YR-MO-DA) you created/revised the file, e.g., Powers—MGT250--

CY2021 Business Plan-DRAFT 020121.docx. The file name now clearly shows the file contents, 

the author, and the file version date. If you later revise the file, rename the file with an updated 

name and the revised date—use the “Save as” feature to save the file, e.g., Powers—MGT250--

CY2021 Business Plan-Rev DRAFT 030121.docx. This technique preserves the earlier file 

version and allows you to refer to it later if necessary. Naming the file with a non-descript name 

like “Homework” or “Marketing Assignment” helps neither the professor nor you, identify the 

contents, author, or version date without opening the file. 

Computer File Organization. You will create many computer files during your Catholic 

University experience. To help organize them on your computer, create a “Catholic University” 

folder on your computer hard drive, on Google Docs, or on your iCloud drive, etc. In the 

“Catholic University” folder, create a folder for each semester (e.g., Fall 2021) with a subfolder 

for each class (e.g., MGT250). File all documents related to that class in the class folder. This 

makes finding and retrieving documents easier. 

  

Note:  After exporting or converting a file into the appropriate Microsoft 

Office format, open, review, and correct the file’s format if changes occurred. 

Unfortunately, the conversion process occasionally changes format. 
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GENERAL DOCUMENT GUIDANCE 

Keep it Short and Simple (KISS). Business and academic writing differ in purpose, 

organization, format, length, and style. Business writing is concise, clear, and focused because 

readers must deal with incredible volumes of data. Businesspeople must prioritize and manage 

massive quantities of email, letters, and other written documents—all demanding attention. And, 

it is not just about keeping letters, email, memos, etc., short; business professionals have neither 

the time nor the desire to sit through a rambling, boring, or overly long presentation either. 

If the audience is receptive to your ideas, recommendations, etc., get to the main point right 

away. Use short sentences/paragraphs and refine your correspondence to avoid unnecessary 

fillers (e.g., Forget the “I am writing to tell you…”). Write in a friendly, conversational tone. 

Avoid slang, acronyms, or jargon unfamiliar to your audience. Regardless of correspondence 

format, place the most vital information upfront, i.e., first, group similar ideas together, and 

include only the most relevant items in your correspondence. 

Once you “complete” your document, you must edit, proofread, and revise it. This is the most 

time-consuming piece of the writing process. A typical first edit should streamline and remove 

about 10-20% of the text. This takes time. Allow enough time for proofreading and editing (you 

should devote about 50% of your document preparation time to the editing, proofreading, 

evaluating part of the writing process).  

Thorough revising, editing, and proofreading will eliminate run-on sentences, comma splices, 

fillers, redundancies, (e.g., “revert back” = “revert”), noun forms (e.g., “extend an invitation” = 

“invite”), and long-winded explanations, etc. Writing in active voice and minimizing passive 

voice helps make your writing more concise. Improve readability by correcting spelling 

mistakes, eliminating grammatical errors, and making correct word choices. Removing clichéd 

business phrases (e.g., “Thank you for your cooperation”) and fancy words (“remuneration”, use 

“salary”) makes correspondence more professional.  

Businesses may also use specific templates for certain documents and will expect you to use 

certain words and phrases in correspondence and other documents. The organization may also 

direct you to avoid certain words, phrases, or references. This ensures consistent branding for the 

business. Following a familiar format and phrasing also makes documents easier and faster to 

read.  

Proofreading Steps. Proofread your document at least three times. Allow enough time for 

thorough review. 

1. Step One: Review Everything 

• Check spelling  

• Review a printed copy for content, clarity, and word choice 

• If time allows, ask colleague to read it over  
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2. Step Two: Review Everything Again 

• Read for content and flow 

• Put yourself in your reader’s place 

✓ All points covered? 

✓ Clear? 

✓ Smooth transitions? 

✓ Logical flow? 

3. Step Three: Now Take a Rigorous Review 

• Look for ways to cut it and make more concise 

• Take out repetitive words/paragraphs/phrases that add no value 

✓ Tighter language conveys focus  

✓ More likely to be closely read if error-free 

✓ Shorter communication saves reader time 

• Verify all facts again (i.e., numbers, names, titles) 

Proofreading Tips 

• Include time in your writing process for proofreading 

• Proofread a printed copy of the document 

• Remember—The more edits you make, the harder it is to find errors 

• Use spellcheck, but do not rely on it blindly (it may accept words spelled correctly but 

used incorrectly, e.g., “to”, “too”, and “two”, or “there”, their”, they’re”) 

• Read your document aloud; then read it backwards, a sentence at a time 

• Have a colleague read it 

Active versus Passive Sentences. Business writing with the most significant impact uses a 

direct and concise style—written in active voice with action verbs. Passive sentences negatively 

affect business writing. The best business documents use personal pronouns and active voice 

sentences. A sentence written in active voice means that the subject of the sentence performs the 

action in the sentence, e.g., “The Dean approved the new program.” A sentence written in 

passive voice means that the subject of the sentence receives an action from someone or 

something else, e.g., “The new program agenda was approved by the Dean.” Active sentences 

help make your point much more succinctly and keep the word count manageable. They also 

convey a bias for action which supervisors appreciate. Your goal should be to keep the 

percentage of passive sentences low – between 5% and 10%, or lower. Use the Readability 

feature built into Microsoft Word to check the readability of your document. The Style Guide has 

fewer than 1% passive sentences.  

Readability. Two factors contribute to document readability: sentence length and word 

difficulty. Small words and short sentences make documents easier to understand. The Flesch 

Readability Score in Microsoft Word calculates reading ease based on the number of words per 

sentence and the number of syllables per word. The Flesch Reading Ease Score (also called a 

Fog Index) reports document reading ease on a scale of 0-100. The higher the number, the easier 

for the reader to understand the document. The lower the number, the more difficult your writing 

is to read. A score of 100 means that your piece is 100% readable. Business documents strive for 

a reading level of 60-70. The higher the score, the better.  
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The Flesch–Kincaid Grade Level shows the readability as a US grade level (grade level needed 

to understand the material). The average American reads at the 7th-9th grade level. The desired 

grade level score for business writing is 8th-10th grade. For maximum impact, aim for the 6th-8th 

grade level. Write for your audience—business executives and people with advanced degrees, 

e.g., scientists and MBAs, comprehend at higher levels. 

 

 

 

 

 

 

  

Flesch Reading Scale 
Score Notes 

90-100 Very easy to read, easily understood by average 11-year-old 

80-90 Easy to read 

70-80 Fairly easy to read 

60-70 Standard; Easily understood by 13- to 15-year-old 

50-60 Fairly difficult to read 

30-50 Difficult to read, best understood by college graduates 

0-30 Confusing and very difficult to read, best understood by university graduates 

Note—the Flesch Reading Scale does not evaluate how well you 

write, it only evaluates the complexity of your writing. 
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SPECIFIC DOCUMENT GUIDANCE 

Business Letter. The business letter is the traditional means of business communication.  

Businesses use letters for important communications, e.g., legal correspondence, proposals, 

recommendation letters, personnel actions, cover letters for contracts, or other official company 

communications.  

Write business letters in Block Format (all information typed flush left), in Times New Roman or 

Arial, 12-point font, single-spaced, with one-inch margins. Organize your letter with the essential 

point (purpose of the letter) first (i.e., Bottom Line Up Front). Edit and proofread your document 

to ensure clarity and conciseness. 

Most businesses use preprinted letterhead or a word processing template with the organization’s 

branding already formatted. If you write a letter without using pre-printed letterhead, type your 

correct legal business name and full business address on the first lines. When using pre-printed 

letterhead, do not re-type your address unless the pre-printed one needs revision. Skip one line 

after the return address and write the date (the actual letter signing or mailing date). 

After the date, skip a line and write the recipient’s full name and address (include the recipient’s 

title, if known). Next is the salutation. Skip a line before the salutation, and begin with “Dear”, 

then the recipient’s formal name and end with a colon (:) (“Dear Mr. / Mrs. / Ms. Last Name:”). 

If you know the recipient personally, you can use their first name (e.g., “Dear Pat:”). Skip 

another line before writing the body of the letter. 

The body of the letter starts with a general introduction of who you are and the letter’s purpose. 

Write in Block Format (single-spaced paragraphs, no paragraph indents, blank line between 

paragraphs). Ensure that the body includes specific paragraphs outlining the issue or problem. 

Close with a call to action or a short, concise summary of the letter’s purpose. Keep the letter 

focused and to-the-point. Avoid using abbreviations, jargon, and acronyms, when possible. 

After writing the body, skip a line and type the closing, followed by a comma. Use a formal 

closing such as “Best Regards” or “Sincerely”, etc. Leave three blank lines after the closing for 

your signature. On the next lines, type your full name and job title (all flush left). Include your 

email address or phone number as needed. Sign the letter (in black or blue ink) in the blank space 

above your name.  

If sending other documents enclosed with the letter, include an enclosure line. Skip a line after 

the Signature Block, and write “Enclosure”, “Enclosures”, or “Enc.” at the left margin. Some 

organizations follow a writing style where authors list each enclosed document separately.1  

If someone other than the recipient will receive a copy of the letter, at the left margin write “c:” 

(copy to), “cc:” (copies to), or write out “Copy to:” or “Copies to:” and list the others receiving 

 
1 William A. Sabin. The Gregg Reference Manual, 11th Ed. (McGraw-Hill: New York. 2011) 

Note—In business correspondence, always follow the person's name in the 

salutation with a colon (:)—not with the comma used in personal letters. 
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copies. 2 Although “cc:” originally meant carbon copies, some businesses may continue to use 

the “cc:” abbreviation. Microsoft Outlook uses “Cc” (Courtesy copy) to show additional email 

recipients receiving a copy of an email. To end confusion with the abbreviations: “cc:” or “c:”, 

write out the words: “Copy to:” or “Copies to:” and list the names of others (in addition to the 

addressee) receiving copies (Note: Do not list the name of the letter addressee here). The Sample 

Business Letter Template is page A-1. 

Memorandum. A memorandum (also called a memo) in an internal document that follows a 

structured format and layout. A memo follows the general business writing standards outlined in 

this Style Guide (block left-justified, one-inch margins, single-spaced text, double-space between 

paragraphs, lists/bullets, and headings). Memos relay decisions, meeting agendas, policies, 

internal reports, and short proposals. The ideal memo is clear, concise, and usually no longer 

than one-page (can be longer if the topic requires more detail).  

Memos: 

• Traditional internal business document 

• Routine, day-to-day communication  

• Cover only one topic  

• Avoid slang and “friendly” words 

• Written in Active Voice 

• No complimentary close 

• More formal than email 

• Share factual or problem-related information 

• Use headings and short paragraphs 

• Make recommendations 

• Slowly replaced by email 

• Written record of actions/decisions 

In general, memos have five major parts: 

1. Heading. 

a. Date:  (in standard US business format) 

b. To:  (name of addressees and job titles) 

c. From:  (your name and job title) 

d. Subject:  (describes memo’s purpose—specifically and to-the-point, i.e., a  

                  well-written subject line attracts reader interest.) 

2. Opening. (Memo’s purpose--frontloads the bottom-line; reveals main idea and purpose)  

3. Body. (Explains & justifies the opening; has background, details, and key benefits; 

logically organizes information and explanations; enhances “skim value” with headings, 

bullets, and numbered lists) 

4. Closing. (Use a courteous ending that outlines next steps / action desired / dates / 

deadlines / closing thought; say who needs to do what, when, where, why, and how) 

5. Attachments. (Attach lists, graphs, tables, and/or other detailed information to support 

and document your reasoning, findings, and recommendations. Do not forget to show 

how the reader and/or the reader’s company will benefit from your recommendations and 

your facilitation of the actions.) 

 
2 Ibid. 
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Unique memo formatting includes:  

• Type the company name one inch from the top, left-justified when using plain paper (not 

required when using company letterhead or a preprinted company form) 

• Insert a double-space below the company name & type “Memorandum” 

• Sign the memo on the “From” line by writing your initials to the right of your name. 

The subject line is a key element of the memo. Keep the subject line brief (7-10 words, i.e., not 

more than one line whenever possible). The subject line captures the main point of the memo 

(why are you sending this memo) and determines whether the recipient will even read the memo. 

Capitalize the subject line as you would capitalize book or article titles 

Memos use guide words (DATE, TO, FROM, SUBJECT) to help give structure and 

standardization. If using plain paper, type the guide words in all caps or with the first letter 

capitalized, double-space the guide words, and format the font in “bold”. Use a left-aligned tab to 

align all words after the colon following the guide words. 

Although all memos follow a similar format and structure, the body may not necessarily be the 

same. Companies may develop a memo structure/format that best fits their organization. In the 

workplace, you will need to adjust to your employer’s style. 

One example is the customized memo format adapted by Dr. Andrew Abela, Busch School 

Dean, from one used by Proctor and Gamble. The body of this memo covers five topic areas 

(The Idea, Background, How it Works, Keys Benefits, and Next Steps). It follows a fixed format 

and normally does not exceed one page. The sample One-Page Memorandum is page B-1. 

Email. Email is slowly replacing traditional business letters and memos as the primary way to 

send information. Why? Email is faster and cheaper than traditional business methods. 

Businesses routinely send letters, memos, reports, business documents, and other information as 

email attachments. Regardless of the medium, the goal for well-constructed email is to 

effectively deliver a clear, easy-to-read message, with the proper tone, to a busy reader.  

Email, unfortunately, is not right for everything. Use a memo or letter when writing messages 

built to last, when format matters, or if people will print your communication. To communicate 

more formally, write a memo or letter and distribute it as an attachment to a brief cover email. 

Write a memo or letter if your message is too long for an email.  

DATE: September 1, 2021 (Date signed—US Business Format, spelled 

out, no abbreviations) 
TO: MGT 250  

FROM:  Bob Powers    BP  (Signature: Person sending memo “signs” by 

writing their initials next to their name) 

SUBJECT: Memo Writing Project Due October 1 (Good practice: include Due Date in Subject)  
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The most important section of your email is the Subject Line. The Subject Line determines 

whether the recipient even opens the email. Write the Subject Line so it invites the recipient to 

open your message. The subject line should concisely describe the email’s essence in 5-7 words. 

• Email vs. E-mail. Is it “email” or “e-mail”? Things in the digital world constantly change. 

Businesses made a big shift over the last five years and the unhyphenated form (email) is 

now the norm (six instances of “email” for every one of “e-mail”). Most of the English-

speaking world adopted the unhyphenated version, e.g., AP Style Book, APA Style Guide, 

Chicago Manual of Style, New York Times, Wall Street Journal, Washington Post, Google, 

and Microsoft. Some editorially conservative publications still prefer “e-mail” to “email”, 

e.g., Merriam-Webster Dictionary and MLA (Modern Language Association) Style Guide. 

The Busch School follows the Catholic University Style and Visual Identity Guide and uses 

“email” (no hyphen). 

• Email Format. Like all business communication, the most vital information goes first, then 

other information in descending order of importance. Format email like a typical business 

letter—block format, single-spaced paragraphs with a double-space between paragraphs. 

Ensure that your email has  

✓ NO grammatical, spelling, or capitalization errors 

✓ NO improper word uses 

✓ NO typographical errors  

Proofread your email before hitting the “SEND” button. Because this step is so important, it 

is repeated for emphasis:  

To reduce embarrassing mistakes, ensure that your email program is set to automatically 

check spelling before sending an email.  

The second and third most important tips are to put the bottom line of your email in the first 

sentence and to keep email to not more than one screen long (busy people tend to scan the 

initial screen and move on to the next message—another reason to put your bottom line in 

the first sentence). If you need more detail, add the extra information as an attachment(s). 

Like printed documents, the first paragraph on a page or screen is usually the shortest 

paragraph, amplifies the subject line, and summarizes the reason for the email. Hint—readers 

will be more likely to read your email if the email is short.  

• Email Style. Email follows an informal writing style, has casual qualities (personal pronouns, 

contractions), and is conversational (“I read your excellent report and predict the Dean will 

approve it.”). Email can also follow a formal writing style if you want to keep professional 

distance between the writer and the reader. Formal writing avoids personal references and 

contractions (“The report is excellent. The Dean is likely to approve it.”). In all cases, a well-

written email is concise, clear, courteous, correct, and to-the-point. Unless you know the 

PROOFREAD YOUR EMAIL BEFORE HITTING THE “SEND” BUTTON. 
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person well, avoid the use of emoji’s, inside jokes, and attempts at humor. Also, avoid saying 

anything inappropriate.  

Professional Guidance—If you would not like to see something quoted 

in a news story, do not write it in an email or post it on social media.  

• Email Organization. Email has four basic sections: Subject Line, Body, Closing, and 

Signature. 

➢ Subject Line — The most important part of your email. Keep it short (5 – 7 words 

maximum) and capture the main point of the email (why are you sending this email). 

The Subject Line determines whether the recipient even opens and reads your email. 

Capitalize the subject line as you would capitalize book or article titles. As with 

memos, you may wish to include due dates in the Subject Line.  

➢ Sample Subject Lines for an Application Email: 

✓ Position Posting Title – Firstname Lastname Application 

✓ Position Title, Job #21543, Firstname Lastname Application 

✓ Job Application: Firstname Lastname, Position Title 

➢ Body — Begins with the name of the recipient, has a generic greeting or a more 

formal salutation, introduces the message with a one-sentence purpose statement that 

expands the subject line, and follows the email format outlined above. 

➢ Closing — Can be informal (e.g., just writer’s name), a little more formal using a 

complimentary closing (e.g., “Thanks”, “Regards”, or similar closing.), or formal 

with a formal complimentary closing (e.g., “Sincerely”, Respectfully”, etc.). 

➢ Email Signature — The email signature block is as important as the subject line. 

Create one that your email software inserts by default for every business-related 

email. In addition to your name, include your company name and contact information 

(your title, workplace phone number(s), and email address).  

 

Why your email address when it is in the “Sent” line of your email? Your recipient 

may forward your email to someone else. Unfortunately, some email programs may 

only include the name and remove the email address of earlier senders. Lastly, avoid 

including any quotes in your Email Signature that might be offensive. (See sample 

email signature on page 3) 

• Email Etiquette. 

✓ Address the individual with “Hello ____”, “Hi____”, or “Dear _____” 

Note: 

• Do not use unnecessary words/fillers 

• Use keywords and get to the point 
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✓ Do not use slang, text language, emojis, or unprofessional language like “love”, 

“omg”, “but srsly” 

✓ Do not demand a response, request a response 

✓ Expect a response within 24-48 hours (you should respond to email in the same way) 

✓ Always sign your email with a closing like: “Thank You”, “Best”, or “Graciously”.  

✓ Use the Subject Line – do not leave it blank; this is a vital part of your email  

✓ Do not write your message as the subject. 

Email Advantages Email Disadvantages 

• Quick, low cost • Not confidential 

• A written record • Easily ignored 

• Speeds up decisions  • May not communicate the writer’s emotional intent 

• Reduces telephone tag • Easily misunderstood or used to avoid difficult live conversations 

Reports. Business reports are structured documents that analyze findings, draw conclusions, 

and make problem-solving recommendations. Although one can write business reports in letter 

or memorandum format, reports are multiple pages long, like memos in organizational style, and 

reflect the culmination of research, analysis, and thought. Formal and informal business reports 

follow the standard business document format (block format paragraphs, business fonts, normal 

margins, single-space line spacing, and a double space after paragraphs). Reports also rely 

heavily on section headings and sub-headings, paragraph headings, and bulleted and numbered 

lists to make the report easier for the reader to find topical areas of importance. 

Informal business reports. Write informal reports as a stand-alone report document, as a 

letter, or as a memorandum. Reports are not restricted to the one-page format preferred for most 

memos and letters. Informal reports written in letter or memo format are multiple pages long and 

follow a standardized format as follows: 

• Introduction. The Introduction introduces the report, gives critical background 

information, and sets the environment for the report. 

• Report Body. The Body is the substance of the report. It can have a variety of sections 

depending on the complexity of the issue and the quantity and variety of detail needed. In 

all cases, the Body describes the problem, the research method, and the findings. It 

discusses, analyzes, interprets, and evaluates research, and offers potential solutions to 

the problem. 

• Conclusions. The Conclusions explain what the findings mean, vis-a-vis solving the 

original problem. Base your conclusions on the findings found in the body of the report. 

Do not include new or added information (information not described in the body) in the 

conclusions section. Writers may find it most effective to list their conclusions together in 

bullet form, and then write a short paragraph for each describing, confirming, prioritizing 

that conclusion. 

• Recommendations. The Recommendations section is the “what should be done” to 

resolve the issue/problem. Draw recommendations from conclusions. Make 
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recommendations precise and focused on resolving the issue. Recommendations 

recommend action and give direction for the path ahead. Do not introduce new or added 

information in the recommendations section. Build recommendations on the conclusions. 

Just like at the end of a memorandum, recommendations must describe who needs to do 

what, when, where, why, and how. 

• Budget or Financial Analysis. This is the “Appendix” section of an informal report. 

Place the budget and financial analysis here.  

Formal business reports. Formal business reports follow a structured format like a research 

paper in tone and professionalism, but follow business writing guidelines in flow, structure, and 

writing style. Formal business reports are usually stand-alone documents read by both internal 

and external audiences. Although one creates a report using a word processing program, you may 

also include spreadsheets, photos, drawings, and other detailed information. Since businesses 

post formal reports on web sites, distribute them as email attachments, or print and distribute 

paper copies to readers, format/assemble the final report as an Adobe Acrobat .pdf document. 

Formal business reports have the following components: 

• Cover. Organizations usually professionally print and bind formal reports with a 

heavyweight or vinyl cover to protect the report and give it a professional appearance. 

Businesses also decorate report covers with company branding, graphics, photo(s), and/or 

the company logo. 

• Title Page. Like a research paper title page, the report title page begins with the title of 

the report in all capital letters, not underlined nor formatted in italics. Next comes the 

name, title, and organization of the person receiving the report. Near the bottom of the 

page is the signature block of the author. The signature block begins with the text: 

“Prepared by” or “Submitted by”, then the author’s name and other identifying 

information. Below the signature block write the date, written in US business format. On 

the Title Page, format the title in all capital letters and all other text in upper and lower 

case. 

• Letter of Transmittal. The Letter of Transmittal is a letter (for an external audience) or 

memo (for an internal audience), written on company stationery. The letter introduces 

the report, announces the report topic, describes the project, highlights report findings, 

conclusions, and recommendations, and ends with reader follow-up actions, 

acknowledgments of help, and offers to assist readers and answer questions. 

• Table of Contents and List of Illustrations. Lists headings, sub-headings, tables, 

figures, and other graphics found in the report and shows their page numbers. Indent 

items as in an outline or write flush left (block format). 

• Executive Summary. The Executive Summary is an overview of the report, written for 

readers who may not have time to read the entire report. The Executive Summary 

summarizes the important points, including recommendations and courses of action. 

Although an Executive Summary can span multiple pages, companies and organizations 

may prefer an Executive Summary that is not more than one-page long. 

• Introduction. The Introduction introduces the report, gives critical background 

information, and sets the environment. Formal reports are redundant by their nature, with 

similar information presented in the letter of transmittal, summary, and introduction. To 
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avoid sounding too repetitious, present information in these areas differently. Even if you 

want to streamline and shorten the report, do not skip the Introduction. Introductions have 

essential information, i.e., background, problem or purpose, topic importance, scope of 

the report (what is and is not included), report structure, and other elements such as key 

terms. The Introduction is normally one page long but can extend over multiple pages 

when you must present a significant amount of information. 

• Report Body. The Body is the substance of the report. It describes the problem, research 

methods, and findings. It discusses, analyzes, interprets, and evaluates research and 

potential solutions to the problem. Title other sections of the report generically, i.e., 

Executive Summary, Introduction, Recommendations, etc. Do not use the title “Body” to 

label this part of the report. Use headings and sub-headings to show the various sections, 

e.g., “Findings”, found in the body.  

• Conclusions. The Conclusion explains what the findings mean, vis-á-vis solving the 

original problem. Writers may find it most effective to list their conclusions together in 

bullet form, and then write a short paragraph for each describing, confirming, and 

prioritizing the conclusion. Draw conclusions from the information presented in the body. 

Do not introduce new information in the Conclusion (i.e., draw Conclusions from the 

Body). 

• Recommendations. The Recommendations section is the “what should be done” to 

resolve the issue/problem. Recommendations must be precise, focused on resolving the 

issue. Draw Recommendations directly from the Conclusions. Recommendations must 

recommend action and give direction for the path ahead. Introduce no new information in 

the Recommendations section. Include the “how to” implement the recommendation with 

each recommendation. Recommendations address the who needs to do what, when, 

where, why, and how. 

• Appendix. The Appendix is at the end of the report and holds the supporting materials, 

like surveys, related reports, data, graphics, letters, and other reference materials. 

• References. The References section is the report’s bibliography. 

Executive Summary. The Executive Summary epitomizes the essence of business writing. It 

is a short synopsis of a report or other document. An Executive Summary is short, to-the-point, 

and clear. It can be a preview of the report and replace the full report for those who choose to not 

read the entire document. It begins with the report context and scope, and then discusses the 

conclusions, recommendations, and the logic justifying them.  

Think of the Executive Summary as your “elevator speech” about the topic – where you 

succinctly summarize the rationale, logic, findings, conclusions, and recommendations from the 

report. Executive Summaries can be as brief as one paragraph or cover multiple pages. The 

majority of Executive Summaries are about a single page long. The length depends on the 

complexity of the topic. Keep the Executive Summary as concise as possible but cover the 

essence of the issue, conclusions, and recommendations with enough information so the person 

reading it understands the topic summarized. 

Oral Report and Presentation Planning. Plan oral reports and presentations just as you do 

written ones. What is your main goal? What are the critical components? Organize the 

presentation to focus on your goal. Make sure both your introduction and closing are strong. Plan 
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for and facilitate discussion.  

Presentations. Any presentation, whether oral or one with slides, requires you to know your 

purpose and to know your audience before you begin to create it. Why? So, you can customize 

your presentation to the audience. Your goal when you finish your presentation should be “What 

do you want your audience to believe, remember, or do?” Focus all presentation parts on that 

singular purpose. Knowing about your audience is vital for a successful presentation. Is the 

audience friendly, neutral, uninterested, or hostile? How do you gain creditability? How do you 

relate your information to their needs? How do you make them remember your main points? 

Presentations fall into broad categories: 

• Conference Room Style. Used by presenters to persuade or educate smaller audiences. 

Conference room style is two-way (interactive), has extensive and relevant detail, is 

normally printed—not projected, uses minimal color (for emphasis only) or no color at 

all, and ensures that the viewer understands slide meaning without reading the text. With 

a smallest font size of 9 points, presenters can include relevant points and multiple ideas 

with fewer pages (1 to ~10 per hour). Businesses successfully use the conference room 

style for smaller audiences (under 50 people). 3 

• Ballroom Style. Used by presenters to inform or entertain larger audiences. Ballroom 

style is primarily one-way (speaker to audience) and characterized by rich, relevant 

visuals, usually projected instead of printed, and has minimal text. As its title shows, 

ballroom style presentations are for larger audiences (50 or more people to thousands). 

Ballroom presentations use color extensively to reinforce the message. To ensure that the 

audience can read the presentation from the back of the room, the smallest font size 

should be 24 points or larger. The length of ballroom presentations varies but one slide 

per minute of presentation is a reasonable size.4 

Presentation Organization. Effective presentations deliver their message three times.  

1. Tell them what you are going to tell them (the Introduction) 

2. Tell them (the Body) 

3. Tell them what you just told them (the Conclusion) 

✓ Introduction. Capture listeners’ attention and get them involved by using a common 

greeting, story, humor, quotation, question, or a startling statement. Then, identify 

 
3 Andrew Abela, Advanced Presentations by Design: Creating Communication That Drives 

Action, 2nd ed. (San Francisco: Wiley, 2013), 113-114. 
4 Ibid 

Important Presentation Advice 

• TALK TO YOUR AUDIENCE—not to your slides 

• DO NOT READ your slides to the audience—tell them more 
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yourself and establish your credibility. Preview your main points. 

✓ Body. Develop two to four main points. This will help you streamline your topic and 

summarize the principal parts. Use the Body to support your main points. Make sure 

to arrange your points logically (follow a pattern) and lead with the most important 

point. Use transitions to guide your audience and to “bridge” your major points, e.g., 

“I’ve just discussed three reasons for X; now I want to move to Y”. Your challenge 

during the Body of the presentation is to keep your audience interested and involved 

throughout the presentation.  

✓ Conclusion. This is the summary of your main themes. Be sure to leave your audience 

with a specific and memorable take-away, due date, action needed, etc. And lastly, be 

prepared to answer questions. 

• Presentation Font. Use a San Serif font (like Arial) for projected presentations. The 

PowerPoint default font (Times New Roman) is difficult to read when projected.  

• Projected Presentation Visibility. When creating your slide deck, avoid putting too 

much information / data / text on one slide. If you have substantial amounts of detail, 

make a paper copy of the information, and pass it out. Do NOT try to project a “white 

paper” that no one can read. Do not create slides with fonts that are too small to read 

easily. 

• Use 28-point for text (24-point minimum) and 36-44-point fonts for slide titles. It is 

acceptable to use an 18-point font—but only for text boxes.  

• Projected PowerPoint Presentations. If you intend to project your presentation, follow 

these generic tips. 

✓ Keep your template simple (Be careful of the standardized templates provided in 

Presentation Methodology 

• Extemporaneous = Usually Best 

• Memorizing = Risky 

• Reading = Difficult & Unnatural 

CAUTION—Some of the standard templates provided with PowerPoint 

may use smaller fonts and/or fonts with pastel or gray colors. These 

fonts may look good on your computer monitor but are extremely 

difficult to read when projected. 

CAUTION: Make sure everyone in the audience can see your slides 

(Hint: stand where you do not block the slides). 
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PowerPoint or other presentation software—many standardized templates look great 

on a computer monitor but do not project well because of font choice/size and color 

and/or slide background color) 

✓ Keep animations and slide transitions simple (just because your presentation software 

can do it does not mean that you should) 

✓ Too many graphics on a slide or in a slide deck reduce effectiveness—keep visuals 

simple (graphs, images) 

✓ Do not rush through slides too quickly (make sure your audience digests each slide). 

✓ Paraphrase the slide text—Do not read your slide to the audience! 

✓ Elaborate on each bullet point (do not just read the bullet points to the audience—they 

can read them also. Give your audience more than slide provides) 

✓ Lastly, proofread your slide deck very carefully 

Résumé and Cover Letter. Two of the most important documents that you will create at The 

Busch School are your Résumé and its Cover Letter. Both documents are your first impression 

on a hiring manager and are vital to your success in your search for your “perfect” workplace 

spot.  

• Cover Letter. A cover letter is more than just a formality. It is an appendix to your résumé 

that puts your résumé in context. Résumés show what you accomplished. Cover letters show 

how you can use your past achievements and experiences to excel in the specific position 

desired. It is your opportunity to set yourself apart from other job applicants, to impress your 

potential employer, to show interest in the job and the employer, to add details about items in 

your résumé, and to separate yourself from candidates with similar qualifications/background.  

✓ Cover letters can make or break your application. A well-written cover letter helps 

employers evaluate your writing style and your attention to detail. Cover letters also 

reveal your work ethic and added dimensions of your personality. Some employers ask 

only for your résumé and not a cover letter—that is unfortunate.  

✓ Tailor your cover letter to both the individual job posting and to the company. Use your 

cover letter to best reflect what makes you the ideal candidate for the position. This is 

your best opportunity to let your potential employer know how you can help them 

succeed and why this opportunity and company interests you.  

• Résumé. A good résumé is also extremely important. It is your first impression on a 

prospective employer—and first impressions count. This is your only opportunity to capture 

an employer’s attention. Statistics show that it is not unusual for hiring managers to spend 

only a few seconds looking at a résumé. Therefore, having a résumé that makes a great 

impression is the secret to a successful job search.  

According to the Merriam-Webster dictionary, there are a variety of spellings of “résumé”; 

variants include “resume” or less commonly, “resumé”. The Style Guide uses the more 

formal version, “résumé”. 
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✓ One way to make your résumé stand out is to follow a great template. The Busch School 

Résumé Template shown in Appendix D is an exceptional template to follow. Employers 

do not care much about your description of duties at a previous job, internship, etc. 

Employers want to know what you did—employers want to know your accomplishments 

and your results.  

✓ Write résumé statements following a simple formula: What was the situation, what action 

did you take, what did you accomplish, and what were the end results of your action?  

➢ Begin with a strong action verb to describe what you did/are doing (See Appendix F 

for some examples) (Analyzed/Analyze--NOT Analyzing) (see Appendix E) 

➢ Briefly state accomplishment (Excel data on new-hire performance metrics) 

➢ End with the results or impact of your action (to evaluate corporate training and 

present outcomes to senior leadership).  

➢ Résumé Experience Example: Analyzed Excel data on new-hire performance metrics 

to evaluate corporate training and present outcomes to senior leadership.  

✓ Résumés follow the same format rules as for business documents, i.e., one-inch margins, 

Times New Roman or Arial, 12-point font, single-spaced, and double-spaced between 

components. 

✓ Undergraduate résumés are usually one-page long. However, because of the volume of 

information that you may want to include, your résumé might not fit on one page. In that 

case, it is permissible to reduce margins to less than one-inch (but never smaller than 0.5 

inches), to use a more-compact font (e.g., “Calibri”), to reduce font size (not smaller than 

10 or 11 points), or to reduce the spacing between paragraphs to less than 12-points (do 

not reduce line spacing to less than single-space).  

If you follow the Busch School Résumé and Cover Letter guidelines, you will also create a 

personalized letterhead for your résumé and cover letter. Use the same letterhead, format, font, 

etc. for both documents. The Cover Letter and Résumé samples are Appendices D-1 and E-1. 

They were vetted by employers and have been well-received in a variety of industries. If 

applying for a government position, see your career coach for slight changes in formatting. 

• Should I send a Cover Letter? If the company offers the option to send a cover letter, yes! 

A cover letter gives you another opportunity to show that you are an ideal fit for the job. If 

you email an application that does not request a cover letter, use the body of your email as a 

mini cover letter—to express your interest in the job, in the company, and your top reason 

for applying.  
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Résumés  Cover Letters 

Demonstrate what you accomplished  Show how you can use past achievements and 
experience to excel in the specific position desired 

Opportunity to show qualifications Opportunity to set yourself apart from other job 
applicants, show interest in the employer and the 
job, add details about the items on your résumé, 
and separate yourself from candidates with similar 
qualifications 

Opportunity to show your impact in your past 
experiences 

Can make or break your application:  
● Must be well-written (shows attention to 

detail and writing style) 
● Reveals your work ethic and added 

dimensions of your personality 

Incorporate keywords from the job posting to 
tailor your résumé bullets to the job 

Tailor your cover letter to the job opportunity and 
the company by blending keywords into the text 

Reflect your prior professional experience Reflect what makes you an ideal candidate: 
● How you can contribute to the company 
● Why the company/opportunity interest you 

Format Rules:  
● See Appendix D for sample 
● 0.5 to one-inch margins 
● Times New Roman / Arial (or Calibri) 
● 11-12 pt. font (10-point minimum) 
● Single spaced 
● Double spaced between components 
● One-page 

Format Rules: 
● See Appendix C for sample 
● 0.5 to one-inch margins (same as résumé) 
● Times New Roman (same font as résumé) 
● 11-12 pt. font (same size as résumé) 
● Single spaced 
● Double spaced between paragraphs 
● One-page  

• How do I save and submit my Résumé and Cover Letter? The file names of your résumé 

and cover letter are extremely important. Create a file name that identifies the file as your 

résumé, the company and/or job applied for, and the date you created the file (use spaces or 

the underline character and/or capitalization to make the file name clear), e.g., 

“BobPowersResume_ABC_Company_ProjMgr 010121. If you send your resume and cover 

letter via email, save both the files as .pdf documents before attaching to your email—all 

computers can open .pdf documents. 

LinkedIn. LinkedIn is a business-centric social networking website used aggressively by 

employers (to find candidates for positions in their companies) and by employees and potential 

employees (to post résumés, to look for job openings, and to learn more about potential 

employers). Since your LinkedIn profile can identify you to potential employers, ensure that it is 

up-to-date, error-free, and correct. LinkedIn is a social media platform used by business 

professionals, by employers, and by those seeking business occupations. LinkedIn is a business 

networking tool and will help you show and keep your professional, digital presence. Your 

LinkedIn profile is important—take time to make sure that it is correct and current. 

Case Analysis. Professors might use the Case Method for their courses. When completing the 
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case analysis, report your findings in the form of a specialized memo as described below. 

• Format. Write your case analysis as a Memorandum and follow the Standard Business 

Format in the Style Guide. 

• Organization. Organize your Case Analysis Memorandum into six parts: 

1. Situational Context – In 100 words or less, describe the situation facing the main 

character in the case. 

2. Strategic Plan – In 100 words or less, describe the main character’s strategy for 

addressing the situation. 

3. Cognitive Model – In 100 words or less, describe the organizing thoughts, metaphors, 

and/or graphics the main character is using to convey the strategy. This is the location 

of a pictorial representation of the cognitive model. 

4. Strategic Rationale – In 200 words or less, explain why the main character pursues 

the strategy. Remember, the strategic rationale may not be explicitly said. If not 

explicitly written, you should infer the rationale from the case facts and exhibits, as 

well as what you have learned about strategy and operations in the MSB Program. 

5. Analysis – In 500 words or less, evaluate the main character’s strategic plan, 

cognitive model, and strategic rationale. Are they appropriate to the situational 

context? This section should reflect critical thinking, a solid understanding of the case 

facts, and incorporate relevant principles of business administration (such as 

economies of scale, market share, growth, profitability, capacity, quality, etc.). You 

may include alternatives to the main character’s strategic plan, cognitive model, or 

strategic rationale in this section. Logically explain why your alternatives are better. 

6. Conclusion(s) – In 200 words or less, summarize your assessment of the main 

character’s leadership performance in the context of the situation they faced. 

• Style. The case analysis is decidedly an academic exercise. That is why the organization 

of your Case Analysis Memorandum differs from the “Answer First” / “Bottom Line Up 

Front” style of most business communication. In a case analysis, you must “set the stage” 

with relevant facts and circumstances before “starting the play” of analysis and 

conclusions. Also, the case analysis is longer than a traditional business memo. Your case 

analyses will typically be 700 words (about two pages) to 1000 words (about three pages) 

in length. The Case Analysis should not exceed 1200 words (about four pages) in length. 

• Grading. You should expect professors to grade your Case Analysis on both style and 

substance. Style refers to following the formatting, organization, and style requirements 

for a Case Analysis as well as the exacting standards of writing expected. Proper 

grammar, spelling, organization, and thought transitioning are all part of style. Substance 

refers to the intellectual quality of your explanations and arguments in the six sections of 

your Case Analysis. Are your explanations supported with case facts? Are your analyses 

and conclusion(s) logical? 
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620 Michigan Avenue (Return address of letter writer) 

Washington, DC 20064  

September 15, 2020 (Date letter signed—US Business format, spelled out, no abbreviations) 

Ms. Helen Jones (Recipient name & address) 

President 

Jones, Jones & Jones 

123 International Lane 

Boston, Massachusetts 01234  

Dear Ms. Jones:  (Salutation) 

Keep a business letter short (i.e., one-page whenever possible). Business people are busy and do 

not have time to read long letters. Bottom line up front! Write in block format (all information 

typed flush left, i.e., no paragraph indent) and use one-inch margins all around).  

• When not using letterhead, type your own address on the first lines, then skip a line and 

insert the date, then skip one more line and type the name and address of the person 

receiving the letter. 

• If you are using letterhead that already shows your address, do not retype the address; just 

begin with the date. Type the date either “flush left” or “centered” under the company 

masthead, depending on your company’s preference and the masthead location. Please 

note that the “date” is the date that the sender signs and sends the letter. 

• For formal letters, avoid abbreviations where possible.  

Skip another line before the salutation and follow the salutation with a colon (:). Write the body 

of your letter with no indent at the beginning of paragraphs. Skip a line between paragraphs.  

After writing the body of the letter, type the closing, followed by a comma, leave three blank 

lines, then type your name and title (if applicable), all flush left. Sign the letter in the blank space 

above your typed name. If the letter has attachments or other documents enclosed, skip a line 

below your title and write the word: “Enclosure” or “Enclosures” to show that there are other 

documents included with the letter.  

Sincerely,  (Closing) 

 

 

Signature  (If sent by mail or fax – sign in blue or black ink) 

John Doe (Sender’s Name) 

Program Manager  (Sender’s title) 

Enclosure(s) (Your organization may want you to list every enclosure individually)  

Copy to: or Copies to: (List those receiving copies in addition to the letter’s Recipient— 

Do not include the letter Recipient’s name here) 

One Blank Line 

One Blank Line 

One Blank Line 

One Blank Line 

One Blank Line 

Three Blank Lines 

One Blank Line 
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M E M O R A N D U M 

Date:  September 21, 2021 

To:  MGT 250 Writing Team 

From:  Bob Powers, MGT 250 Writing Team Lead    BP  

Subject: One-Page Memo 

The Idea. What do you propose? (One sentence) 

Background. What led you to this recommendation? (Include only non-debatable information in 

the Background section -- this is the basis for discussion, so it needs to be non-debatable) 

How it Works. The details (How, What, Who, When, Where) 

Key Benefits. This is the "Why?" There are usually three benefits:  

• Recommended action is on strategy 

• Recommended action already proven (e. g., in test market or in another business unit) 

• Recommended action will be profitable  

You can think of these three in terms of "doing right things right." The first (on strategy) 

means you are doing the right thing. The second and third mean you are doing things the 

right way because you are effective (proven to work) and efficient (profitable). 

Next Steps. Who needs to do what and by when for this to happen? 

Please note the use of headings and bullets that allow readers to quickly scan the document for 

the sections of importance to them. 

Copies to:  xxxxxxxx 

 xxxxxxxx 

 xxxxxxxx 

Note: Paragraph Summary Descriptions created by Andrew Abela, Ph.D. 
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Cover Letter Tips 

• Customize your cover letter for a specific employer 
and job description. Templates are easy to spot and 
reflect poorly on your interest in the position. 

• Address the letter to a specific individual. If the 
job announcement has no name or contact person 
listed, call the organization to learn who is on the 
hiring team. If all else fails, use a generic salutation, 
like “Dear Hiring Manager:” or “Dear Search 
Committee:” Do not use “To Whom it May Concern:” 

• Isolate three or four of your best skills relevant to 
the position. Use concrete examples from your 
résumé that show and emphasize these skills. 

 

Your Name (use 14-point, bold font) 
Street Address, City, State ZIP Code, email address, phone number 

Date Signed 

Addressee’s name and title  

Name of company  

Mailing address  

City, State Zip Code  

Dear Dr. / Mr. / Ms. _______________:  

The opening paragraph is your introduction. State your major and Catholic University graduation 

year. Include the reason for your letter including job title, resource from which you heard about 

the vacancy (Handshake, LinkedIn, or other), job listing number (if there is one), and any other 

pertinent information to ensure the employer understands what job you want. (2-4 sentences) 

In the next paragraph(s), show your interest in the company and the job, what makes you 

qualified for the position, and how the position relates to your personal interests or experiences. 

Match your qualifications with those listed as required on the job description. Emphasize the 

aspects of your education, experience, specific skills, etc., that are relevant to the position 
desired.  

Using a cover letter template is obvious to an employer, so write a customized letter for each 

employer/job. Do not duplicate the exact wording of your résumé. Keep it concise (4-6 

sentences) but be sure to isolate two to three of your skills that match the job description and 

connect them to your previous experiences. (For example: Skill: Proficient in Excel. Sentence: In 

my role at _____, I used Excel extensively to complete [insert job function here], which will help 

me when using Excel in my role as [insert job title here.]) 

In the last paragraph, express your interest to provide more information during a personal 

interview. You then may say that you will call the employer on a certain date (or in 10 days, one 

week, or whatever timing you want) to arrange for an appointment to further discuss your 

qualifications in-person with the employer. End with a thank you for their time and 

consideration.  

Sincerely,  

Signature (Your signed signature) 

Your typed signature  

Enclosure (Résumé) 

 

  

Copy your Résumé Contact 
Information here (include your 
name, complete mailing address, 
email address, and phone number) 

 

Use US Business format 
(Month date, four-digit year) 

Do not use the header or 
footer for personal information, 
e.g., name, etc. 
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FIRSTNAME LASTNAME 
City, State Zip Code | youremail@cua.edu | (202) XXX-XXXX | www.linkedin.com/mylinkedin 

EDUCATION (required) 

The Catholic University of America 

The Busch School of Business Graduation Month Year 

Degree (e.g., Bachelor of Science in Business Administration in Finance) GPA: (If above 3.3 or if company asks) 

● Relevant coursework: (optional)  

● Honors/Awards: Dean’s list or other awards/recognition (optional) 

 

ACADEMIC PROJECTS (optional) 
Corporate Project XYZ, Management 299 Month Year - Present 

● Collaborated with a team of five to analyze… 

● Designed marketing strategy to... 

 

 

 

PROFESSIONAL EXPERIENCE (required) 
Company Name (most recent), City, State 

Position Title Month Year - Present 

● Strong action verb in PRESENT tense (if currently working), PAST tense otherwise.  

Focus on accomplishments and results. Use Action > Result formula 
● Communicate cross-functionally to deliver... action/accomplishment/result 
● Collaborate with a team of four... action/accomplishment/result 
● Analyze financial statements... action/accomplishment/result 

 

Previous Company Name, City, State 

Position Title Month Year - Month Year 

● Strong action verb in PAST tense. Focus on accomplishments and results.  

Use Action > Result formula 
● Delivered presentation to a senior manager... action/accomplishment/result 
● Created digital marketing strategy for a major client... action/accomplishment/result 
● Conducted competitive analysis of the XX industry... action/accomplishment/result 
● Built client relationships and business opportunities by... action/accomplishment/result 

 

VOLUNTEER / LEADERSHIP EXPERIENCE / ACTIVITIES (required) 
Organization Name, City, State 

Position Title Month Year - Month Year 

● Strong action verb in PAST tense. Focus on accomplishments and results. Use Action > Result formula 
● Led a campaign to increase membership... action/accomplishment/result 
● Helped launch an initiative in the community to... action/accomplishment/result 

 

CERTIFICATIONS / SKILLS (optional) 
Languages: Native speaker of X. Fluent in Z. Conversational in Y 

Computer:  Microsoft Excel, Microsoft Word, PowerPoint, Prezi, SurveyMonkey, Adobe Suite, Google 

Analytics Certified 

Write your address and 
other contact information 

on either one or two lines 

Title section 
based on your 
experience 

Title section 
based on your 
experience 

Highlight any projects you worked on that relate to the desired job, 
e.g., a major marketing strategy project if you apply for marketing 
related jobs, e.g., “What was the problem?”; “What action or 
analysis did you perform?”; and “What was the result?” 

Use right-aligned 
tab to align all dates 
at right margin 

Other things to include:  
Sports: Include relevant clubs, or sports/extracurricular activities 
Leadership: include any leadership positions at school (e.g., student clubs, sports, government) 

Date format 
May 2022 – with no comma 

Do not use the header or 
footer for personal information, 
e.g., Name, contact info, etc. 

mailto:youremail@cua.edu
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FIRSTNAME LASTNAME 
City, State Zip Code | youremail@cua.edu | (202) XXX - XXXX | www.linkedin.com/mylinkedin 

EDUCATION (required) 

The Catholic University of America 

The Busch School of Business 

Master of Science in Business Month Year of Graduation 4 

● Capstone Project: GPA: (If above 3.5 or if company asks for it) 

 

Undergraduate School 

Degree Month Year of Graduation 

● Relevant coursework: (optional) GPA: (If above 3.5 or if company asks for it) 

● Honors/Awards: Dean’s list or other awards/recognition (optional) 

 

ACADEMIC PROJECTS (optional) 
Corporate Project XYZ, Management 299 Month Year — Present 

● Collaborated with a team of five to analyze… 

● Designed marketing strategy to... 

 

 

 

PROFESSIONAL EXPERIENCE (required) 
Company Name (most recent), City, State 

Position Title Month Year — Present 

● Strong action verb in PRESENT tense (if currently working), PAST tense otherwise. Focus on 

accomplishments and results. Use Action > Result formula 
● Work cross-functionally to deliver... action/accomplishment/result 
● Collaborate with a team of four... action/accomplishment/result 
● Analyze financial statements... action/accomplishment/result 

 

Previous Company Name, City, State 

Position Title Month Year — Month Year 

● Strong action verb in PAST tense. Focus on accomplishments and results. Use Action ->Result formula 
● Delivered presentation to senior manager... action/accomplishment/result 
● Helped create a digital marketing strategy for a major client... action/accomplishment/result 
● Conducted a competitive analysis of the XX industry... action/accomplishment/result 
● Built client relationships and business opportunities by... action/accomplishment/result 

 

VOLUNTEER/LEADERSHIP EXPERIENCE / ACTIVITIES (required) 
Organization Name, City, State 

Position Title Month Year — Month Year 

● Strong action verb in PAST tense. Focus on accomplishments and results. Use Action > Result formula 
● Led a campaign to increase membership... action/accomplishment/result 
● Helped launch an initiative in the community to... action/accomplishment/result 

CERTIFICATIONS/ SKILLS (optional) 
Languages: Native speaker of X. Fluent in Z. Conversational in Y 

Computer:  Microsoft Excel, Microsoft Word, PowerPoint, Prezi, SurveyMonkey, Adobe Suite, Google 

Analytics Certified

Title section 
based on your 
experience 

Highlight any projects you worked on that relate to the desired job. 
e.g., a major marketing strategy project if you apply for marketing 
related jobs, e.g., “What was the problem?”; “What actions or 
analyses did you perform?”; and “What was the result?” 

Do not use the header or 
footer for personal information, 
e.g., name, etc. 

Write your address and 
other contact information 
on either one or two lines 

Use right-aligned tab to align 
all dates at right margin 

Date format 
May 2022 – with no comma 

(Other things to include:  
Sports: Include relevant clubs, or sports/extracurricular outside of school  
Leadership: include any leadership positions at school (e.g., student clubs, government) Title section 

based on your 
experience 

mailto:youremail@cua.edu
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Action Verbs for a Powerful Resume 
 

Communication  
Skills 

Teamwork,  
Supervision  

Skills 

Management,  
Leadership  

Skills 

Research  
Skills 

Clerical,  
Detail  
Skills 

Creative  
Skills 

authored advised authorized analyzed activated acted 

briefed coached chaired assessed adapted composed 

clarified convened coordinated collected approved conceptualized 

collaborated coordinated directed compared arranged created 

drafted demonstrated established critiqued catalogued customized 

edited developed executed defined classified designed 

explained educated headed detected compiled developed 

integrated eliminated implemented determined designed directed 

interpreted encouraged improved diagnosed edited established 

mediated evaluated increased discovered generated fashioned 

negotiated expedited instilled formulated maintained founded 

persuaded facilitated managed gathered monitored illustrated 

presented  guided motivated inspected organized integrated 

promoted motivated organized interpreted prepared invented 

publicized set goals planned investigated processed originated 

resolved simplified prioritized located proofread performed 

summarized supported scheduled reviewed recorded revitalized 

translated trained strengthened studied streamlined shaped 

wrote tutored supervised systematized updated solved 



Using Google Workspace with Google Docs and Microsoft 
Office Files 
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To add Microsoft Office files to Google Drive  

1. Open Drive 

2. Click “New” > “File Upload” 

3. Choose the Office file you want to upload 

Open Office files in Drive. If you are sharing Office files with people who only have Office, 

you can work on them in Docs, Sheets, and Slides, but save them as Microsoft files in Drive. 

Chrome Browser only: 

1. Make sure the “Office Editing for Docs, Sheets, & Slides” extension is not installed 

a. Open Chrome: (in the top-right corner), click “More” > “More Tools” > “Extensions” 

b. If you see the “Office Editing for Docs, Sheets, & Slides” extension, click “Remove” 

2. In Drive: double-click an Office file 

You can now edit, share, view version history, collaborate in real-time with others, and more. All 

changes you make are saved to the original Office file. 

Convert Office files to Google files. If you and your colleagues are only working in Google 

Docs, Sheets, and Slides, you can convert Office documents and PDF files to Docs, Sheets, or 

Slides. 

1. Open Drive and double-click an “Office” file 

2. Click “File” > “Save as Google Docs/Sheets/Slides” 

To automatically convert all future uploads of Office files to Google Docs, Sheets, or Slides 

1. In Drive: (at the top), click “Settings” > “Settings” 

2. Next to “Convert uploads”, turn on “Convert uploaded files to Google Docs editor format” 

Note: Previously uploaded files will not be converted. 

Work in Office and sync files to Drive (Office required). After you move your Office 

files to Drive, you can still work on them in Office and save your changes to Drive. 

1. If you have not already, install “Drive File Stream” on your computer  

This adds your Google Drive folder to your computer. 

2. On your computer, add your Office file to your “Google Drive” folder 

3. In Office: click “File” > “Open” and find your Google Drive folder 

4. Click your Office file and click “Open” 

5. Edit your file 

Any changes you make to your file in Office will synchronize in Drive. 



Using Google Workspace with Google Docs and Microsoft 
Office Files 
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Comment on Office files. When you comment on an Office file in Docs, Sheets, or Slides, 

the comment appears in Office, too. 

1. Open Drive and double-click an Office file 

2. Select the text, cell, or section you want to comment on 

3. Click “Add comment” 

a. Enter your comment. To address it to a specific person, enter “+” and their email in the 

comment text, e.g., +powersrf@cua.edu 

4. Click “Comment” 

Share a copy of a file in an Office format. If you are sharing a Google file with people 

who only have Office, you can attach a Microsoft copy to an email. 

1. In Docs, Sheets, or Slides: open the file 

2. Click “File” > “Email as attachment” 

3. Under “Attach as”, choose “Microsoft Word, Microsoft Excel, or Microsoft PowerPoint” 

4. Enter the email address, subject, and message  

5. (Optional) Check the “Send a copy to myself” box 

6. Click “Send” 



Convert Apple Pages Files (.pages) to MS Word (.docx) Files 
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Pages. Pages is an Apple word processing program available on Mac computers, iPads, etc. 

Pages is a free Mac app available from the Apple App Store. Unfortunately, Pages files are not 

currently compatible with Microsoft Office products. If you choose to use Pages, you must 

export your file from within Pages and create a .docx file compatible with MS Word. If you use 

Keynote or Numbers, follow a similar process to create files compatible with PowerPoint / Excel. 

If using Pages, update the app to the newest version with the latest features. That will improve 

compatibility when saving MS Word documents. 

Convert Pages File to MS Word .docx File. 

1. Open your “Pages” file in “Pages” App 

2. Go to the File menu 

3. Choose Export To  

4. Select Word from the submenu 

5. At the Export Your Document screen 

(under Word tab), click the triangle 

next to Advanced Options 

6. Select the proper Word file format 

(.docx) 

7. Save As: Name new Word file 

8. Where: Select destination folder  

9. Choose Export 

 

Note: Complex formatting, unique fonts, or 
stylized ascii, Emoji, or special OS X / Pages 
characters, may cause compatibility issues 
with MS Word 

✓ Keep saved/exported files simple  

✓ Use standard, across-platforms fonts, e.g., 
Times Roman or Arial  

✓ Avoid unusually complex document 
formatting 
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WINDOWS (MS WORD). After making the font, paragraph, and margin selections your 

default settings, you will produce MS Word documents in The Busch School style format. These 

settings are also the normal format for business documents. 

• Font.  

1. Open MS Word and open a new document 

2. On the Home tab, click on the “Font Dialog Box Launcher” (See Arrow) 

3. In the Font Dialog Box, scroll thru the font 

list and select Times New Roman or Arial 

(your choice), if not already selected.  

4.  Select  

• Font Style: “Regular” 

• Size: “12” 

• Font Color: “Automatic” 

• Underline Style: None 

• Effects: NO boxes checked 

5. Click on: “Set as Default” 

 

 

 

  



Computer Setup for Business Documents (MS Word) 
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• Paragraph and Line Spacing.  

• On the Home tab, click on the “Paragraph Dialog Box Launcher” (See Arrow)

 

• On the “Paragraph Dialog Box”, click on the “Indents and Spacing” tab 

• Select 

• Alignment: Left 

• Outline Level: Body Text 

• Indentation: “0” 

• Special: None 

• Spacing:  

a. Before: “0 pt.” 

b. After: “12 pt.” 

• NO boxes checked 

• Click on: “Set as Default” 

 

 

 

• Margins. 

1. On the Layout tab, click on “Margins”  

 



Computer Setup for Business Documents (MS Word) 
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2. In the “Margins Dialog Box”, select “Custom Margins” 

 

  

 

 

 

 

3.  Select  

• Margins:  Top: 1” Bottom: 1” 

  Left: 1” Right: 1” 

  Gutter: 0” Gutter Position: Left 

• Orientation: Portrait 

• Multiple Pages: Normal 

• Apply to: Whole Document 

4. Click on: “Set as Default” 

 

 

 

 

 

  



Computer Setup for Business Documents (MS Word) 
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• Ruler. You may find it useful to have the “Ruler” displayed. The “Ruler” shows margins. 

tabs, and other formatting features.  

1. To view the “Ruler”, click on the “View” tab 

2. Click on the checkbox next to “Ruler” 

3. Screen with “Ruler” shown below ribbon 

  



Computer Setup for Business Documents (MS Word) 
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• Spelling and Grammar.  

1. To set Spelling and Grammar parameters, select “File” 

2. On the “File” menu, select “Options” 

 

 

 

 

 

3. On the “Word Options” Dialog Box, select “Proofing” 

4. In the “When correcting spelling in Microsoft Office programs” section, check all blocks 

except those referring to foreign language and using only the main dictionary.  

5. In the “When correcting spelling and grammar in Word” section, check all boxes.  



Computer Setup for Business Documents (MS Word) 
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6. For “Writing Style”, select “Grammar & Refinements”. Then select “Settings”. 

7. In the “Grammar & Refinements” dialog box, check all options. 

 



Computer Setup for Business Documents (Word for Mac) 
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WORD FOR MAC. 

• Font.  

1. Open Word for Mac and open a new document 

2. On Format tab, click on “Font” (“COMMAND + D” also opens Font dialog box) 

3. In the Font Dialog Box, click on the Font tab.  

4. Scroll thru the font list and Select  

• Font: Times New Roman, Arial, or 

Helvetica (your choice)  

• Font Style: “Regular” 

• Size: “12” 

• Font Color: “Automatic” 

• Underline Style: None  

• Effects: No boxes checked 

 

  



Computer Setup for Business Documents (Word for Mac) 
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5. Click on the Advanced tab  

6. Select  

• Scale: “100%” 

• Spacing: “Normal” 

• Position: “Normal” 

• Ligatures: None 

• Number spacings: “Default” 

• Number forms: “Default” 

• Stylistic sets: “Default” 

 

 

 

7. Click on “Default” 

 

8. When you see the following Dialog Box, select “All documents based on the Normal 

template?” Click on “OK”. 

  



Computer Setup for Business Documents (Word for Mac) 
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• Paragraph and Line Spacing.  

1. On Format tab, click on “Paragraph” (“COMMAND + M” also opens Paragraph 

dialog box)  

 

2. In the Paragraph Dialog Box, select the “Indents and Spacing” tab 

3. Select  

• Alignment: “Left” 

• Outline Level: “Body Text” 

• Indentation:  

i. Left: “0” 

ii. Right: “0” 

iii. Special: “None” 

• Spacing: 

i. Before: “0 pt.” 

ii. After: “12 pt.” 

iii. Line spacing: “Single” 

• Uncheck: “Don’t add space between 

paragraphs of the same style” 

  



Computer Setup for Business Documents (Word for Mac) 
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4. Click on: “Line and Page Breaks” 

5. Uncheck: All boxes except 

“Window/Orphan Control” 

 

 

 

 

6. Click on: “Set as Default”  

 

 

 

7. When you see the following Dialog Box, select “All documents based on the Normal 

template?” Click on “OK”.  

  



Computer Setup for Business Documents (Word for Mac) 
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• Margins 

1. On Format tab, click on “Document” 

2. In the Document Dialog Box, select the “Margins” tab 

3. On Margins dialog box, select  

• Top: 1” Bottom: 1” 

Left: 1” Right: 1” 

Gutter: 0” Gutter Position: Left 

• Multiple Pages: Normal 

• Apply to: Whole Document 

 

 

 

 

 

4. On the Layout dialog box,  

• Ensure “Header” and “Footer” equal “0.5” 

• Click on: “Default...” (on either tab) 

 

 

 

5. Select “Page Setup...” from either “Margins” or 

“Layout” dialog box  

6. Select “Page Attributes” from the dropdown menu  

• Format for: Your printer OR “Any Printer” 

• Paper Size: US Letter 

• Orientation: Portrait 

• Scale: “100%” 

7. Click on: “OK” 

8. Click on: “Default”  

 



Computer Setup for Business Documents (Word for Mac) 
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9. When you see the following Dialog Box, select “All documents based on the Normal 

template?” Click on “OK”.  

• Ruler. You may find it useful to have the “Ruler” displayed. The “Ruler” shows margins. 

tabs, and other formatting features.  

1. To view the “Ruler”, click on the “View” tab 

2. Click on the checkbox next to “Ruler” 

 

 

3. Home tab with Ruler shown 

  

Note: You can also set Margins from within a  

document by clicking on the “Layout” tab. 

• Click on the “Margins” icon 

• “Margins” dropdown menu appears  

(shows the current margin selected) 

•  Select “Custom Margins...” 

• Follow the instruction concerning the  

Paragraph Dialog box above.  

Word for Mac showing the Ruler 



Computer Setup for Business Documents (Word for Mac) 

July 2021 Appendix H-13 Style Guide 

• Spelling and Grammar. To receive maximum benefit from the spelling and grammar 

checker built into Word for Mac, make the following setup. 

1. On the Word tab, select “Preferences” from the 

dropdown menu 

2. From the Word Preferences Dialog box, select 

“Spelling & Grammar” 

3. On the Spelling Grammar dialog box, check ALL boxes, except “Suggest from main 

dictionary only” 



Create a Business Document Template 
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Business Document Template for Microsoft Word. Create a business document template if 

you choose not to setup your word processor to only create documents following the business 

standard. The template would allow you easily to create documents following the business 

standard for font, font size, margins, line/paragraph spacing, header/footer location, or paragraph 

justification, etc. Both the Windows and Mac versions of MS Word use similar processes. 

1. Open a new blank Word document 

2. Use the “Save As” command.  

3. Click on the “Save as type” drop down menu to save your file as a “Word Template” 

4. Name the template something like, “Business Document Template.dotx” 

5. Format margins, line spacing, font, paragraph justification and spacing, header, footer, 

etc. Use the same formatting as the default computer format settings described elsewhere 

in the appendix, except DO NOT Set as Default. 

6. Save and close the template 

7. Open a “new” document and select your 

Business Document Template under the 

“Personal” tab 

8. Click on the “Personal” tab 

9. Open the Business Document Template 

10. Immediately use the “Save As” command to save the new document as a Word 

Document (.docx) with the document’s new filename in the folder where you save your 

class files (this ensures that you do not overwrite the template) 

11. Complete your new document in the normal manner 
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Keyboard Shortcuts 
Keyboard shortcuts allow you to take actions normally completed with your mouse. 

(Hold down the Control/ Command at the same time as typing the letter 

Windows Mac Action 
Ctrl + A Command + A Select all items in document or window 

Ctrl + B Command + B Make selected text BOLD 

Ctrl + C Command + C Copy selected text/item to clipboard 

Ctrl + D Command + D Delete selected item/Move item to recycle bin 

Ctrl + F Command + F Find text in open window/document 

Ctrl + G Command + G Find next instance of something / Find and Replace 

Ctrl + I Command + I Make selected text Italic 

Ctrl + N Command + N Create or launch new document/file/window  

Ctrl + O Command + O Open selected item, URL, document, image, or another file type 

Ctrl + P Command + P Print 

Ctrl + S Command + S Save 

Ctrl + U Command + U Underline selected text 

Ctrl + V Command + V Paste text/item from clipboard 

Ctrl + X Command + X Cut selected item 

Ctrl + Y Command + Y Redo last action 

Ctrl + Z Command + Z Undo previous action 

For a complete list of keyboard shortcuts, search support.microsoft.com for “keyboard 

shortcuts” or go to https://support.apple.com/macos and in the “Search for More Topics” 

window, search for “shortcut”.  

You can also explore these links: https://support.microsoft.com/en-us/windows/keyboard-
shortcuts-in-windows-dcc61a57-8ff0-cffe-9796-cb9706c75eec (Windows) or 

https://support.apple.com/en-us/HT201236 (MacOS). 

Insert Special Characters Using Alt Codes 

You can insert a variety of equations, symbols, and foreign language letters/characters into a 

document using the Equation and Symbol buttons on the “Insert” Tab in Microsoft Office Apps. 

You can also insert these characters and symbols using an “Alt Code” (Alt keyboard key + a 

number using the numerical keypad (e.g., Alt + 0169 = © or Alt + 130 = é) 

To type a character using its Alt Code value, Num lock should be on.  

The numeric keypad does not exist on every laptop. To use them, Numpad should be activated 

by pressing down the Fn key (https://techtestreport.com/how-do-i-lock-and-unlock-the-fn-
key/).  

The list of “Alt Codes” for Windows computers can be found here 

(https://support.microsoft.com/en-us/topic/insert-ascii-or-unicode-latin-based-symbols-
and-characters-d13f58d3-7bcb-44a7-a4d5-972ee12e50e0). 

The list of “Alt Codes” for MacOS computers can be found here 

(https://www.webnots.com/option-or-alt-key-shortcuts-to-insert-symbols-in-mac-os-x/).  

http://support.microsoft.com/
https://support.apple.com/macos
https://support.microsoft.com/en-us/windows/keyboard-shortcuts-in-windows-dcc61a57-8ff0-cffe-9796-cb9706c75eec
https://support.microsoft.com/en-us/windows/keyboard-shortcuts-in-windows-dcc61a57-8ff0-cffe-9796-cb9706c75eec
https://support.apple.com/en-us/HT201236
https://techtestreport.com/how-do-i-lock-and-unlock-the-fn-key/
https://techtestreport.com/how-do-i-lock-and-unlock-the-fn-key/
https://support.microsoft.com/en-us/topic/insert-ascii-or-unicode-latin-based-symbols-and-characters-d13f58d3-7bcb-44a7-a4d5-972ee12e50e0
https://support.microsoft.com/en-us/topic/insert-ascii-or-unicode-latin-based-symbols-and-characters-d13f58d3-7bcb-44a7-a4d5-972ee12e50e0
https://www.webnots.com/option-or-alt-key-shortcuts-to-insert-symbols-in-mac-os-x/

